
Game menu commands

The Game menu offers the following commands:

New Starts a new game.
Undo Move Undo the last move.
Redo Move Redo the last move that was undone.
Exit Exits Peg Solitaire.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Show Moves Turns on or off the highlighting of possible moves
Show Winning
Moves

Turns on or off the highlighting of moves that allow a 
game to be won.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get 
help.

About PegSol Displays the version number of this application.



New Game command (Game menu)

Use this command to start a new game.    If the current game still has playable moves, an 
alert panel warns you that you will be abandoning the current game.

Shortcuts
Keys: CTRL+N



Undo Move command (Game menu)

Use this command to undo the previous move.    This command can be repeated to undo all 
moves until the start position is reached.    To redo a move that has been undone, use the 
redo move command.

Shortcuts
Keys: CTRL+Z



Redo Move command (Game menu)

Use this command to redo a move that has just been undone using the undo move 
command.    This command is only available if one or more moves have just been undone.

Shortcuts
Keys: CTRL+Y 



Exit command (Game menu)

Use this command to quit the application.    You can also use the Close command on the 
application Control menu. 

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Peg Solitaire.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Show Moves command (View menu)

Use this command to enable or disable the option that lights up in blue, pegs that can be 
moved.    When the cursor is moved over a highlighted peg, the holes to which the peg can 
be moved also light up in blue.    When this option is enabled, a check mark appears next to 
menu item, and if the toolbar is displayed, the toolbar button is depressed.    See also: game 
options.



Show Winning Moves command (View menu)

Use this command to enable or disable the option that lights up in green, pegs that can be 
moved to lead to a winning game.    When the cursor is moved over a highlighted peg, the 
holes to which the peg can be moved in order to win also light up in green.    When this 
option is enabled, a check mark appears next to menu item, and if the toolbar is displayed, 
the toolbar button is depressed.    See also: game options.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to several commands used in Peg Solitaire.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Start a new game.

Show/hide possible moves.

Show/hide moves that allow the winning position to be reached.

Bring up the About box.

Bring up the context sensitive help cursor.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button. A check mark appears 
next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the game window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar 
buttons as you depress them, before releasing them.    If after viewing the description of the 
toolbar button command you wish not to execute the command, then release the mouse 
button while the pointer is off the toolbar button.



Using Help command (Help menu)

Use this command for instructions about using Help.



Help command (Help menu)

Opens the help window, showing the contents.

To get context sensitive help on the currently selected object, press F1.

Shortcut
Keys: ALT, H, H



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Peg 
Solitaire.

Shortcut
Keys: ALT, H, A



Context Help command 

Use the Context Help command to obtain help on some portion of Peg Solitaire.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Peg Solitaire window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Peg Solitaire window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Peg Solitaire determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. Peg Solitaire 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the application or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to play

Peg Solitaire is played on a board that consists of a number of holes.    At the start of the 
game, all the holes contain pegs except the center hole.

The aim of the game is to remove pegs from the board one by one, until only the center peg 
is left. 

Pegs are removed by jumping another peg over them, either horizontally or vertically.    The 
peg being moved must be adjacent to the peg being removed, and there must be an empty 
hole on the opposite side.    To help learn the moves, use the game options to highlight the 
pegs that can be moved.

Once there are no pegs that can be removed, the game is over.

Starting position

Winning end position.



Game Options

There are two options that can be set when playing the game:

· Show winning moves.    This puts the game into "cheat" mode.    In this mode, all moves 
that can be made which will lead to a winning game are shown.    This is done by lighting 
in green the pegs that can be moved, as shown below.    When the cursor is moved over 
one of these lit pegs, the holes that it can be moved to are also shown lit in green.

· Show all moves.    This puts the game into "help" mode.    Use this mode to help learn 
which moves are allowed.    Any pegs that can be moved are shown lit in blue, and when 
the cursor is moved over one of these lit pegs, the holes that it can be moved to are also 
shown lit in blue.

Example move with no highlighting.

Example move, with the show-all-moves option turned on.

Example move that leads to a winning game, with the show-winning-moves option turned 
on.



History of Peg Solitaire

Peg Solitaire dates from the early 18th Century, and is traditionally played on a wooden 
board with drilled holes for the pegs.    This program implements the English game, which is 
the most common.    

English game

Other variations are the French version, and a triangular version.    These differ in the 
arrangement of the holes as shown below.

French game

Triangle game



If you want to know more about Peg Solitaire, try looking at "The Ins and Outs of Peg 
Solitaire" by John D. Beasley, publisher Oxford University Press 1985.    ISBN: 0 19 286145 X 
or 0 19 853203 2.



Fascinating Facts & Figures

Although Peg Solitaire appears to be a very simple game, a huge number of possible games 
can be played out.

There are 8,589,934,592 possible arrangements of the pegs on the board (this is 2 raised to 
the power 33, since there are 33 holes on the board, each of which may be empty or have a 
peg in it).

However, of these, only 281,657,274 positions can be reached from the starting position.

And of these, only 13,431,459 positions lead to the winning game.

You can make any moves you like for the first 3 moves, and be in a position from which you 
can still win.    After that, you have to be careful!

The worst ending position has 26 pegs left.



Abandon Game message box

This message box comes up if you ask to start a new game while the current game still has 
moves left to play.    Press YES to abandon the current game, or NO to continue playing.



About Extrabit Software

Peg Solitaire is brought to you by Extrabit Software.    For more great software, visit our web 
site at http://www.extrabit.com.
{button Open Web Page Now,EF(`www.extrabit.com/index.html',`',1)}

If you have any questions, comments (or even bug reports!), send email to 
support@extrabit.com.



End user license

Peg Solitaire is free, but it is not public domain.    You must agree to the following terms if 
you wish to use and distribute this program.

Distribution

You may make as many copies of this software and documentation as you wish.    You may 
freely distribute this software by any means provided that you include all files in the original 
distribution, and none of the files are altered in any way.

Governing Law

This agreement shall be governed by the laws of England.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE PROVIDED "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.

PegSol Copyright © 1998,1999 by Mark Williams. All rights reserved.




